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THE
U.S.S.BLACKHAWK
TECHNICAL MANUAL

INTRODUCTION

TO ALL NAVY PERSONNEL

TO ALL NAVY PERSONMNEL- You are a part of the
largest and strongest seagoing force in the world.
When you were sworn in and put on your uniform
tor the first time, you became part of a great
tradition. All the brave men and women who have
gone before you, and those who will follow you,
make up an unbroken chain of courage and
devotion to duty that should make you proud to
wear your uniform.

Service in the Navy can be whatever you make it. It
takes some time to und 1d and b
adapted to the ways of the Navy, for going to sea
in ships is a tough, serious business, particularly
in troubled times. It you must work hard at times,
miss a leave period or a few liberties in your home
port, remember that you chose a demanding job
when you joined the Navy.




BOARDING PROTOCOL

Salute Flag - When standing on the gangway, prior 10 stepping aboard, face aft and
“salute the flag".

Salute (Hficer of the Deck - After the abave, tum and face the Officer of the Deck,
salute and ‘request permission to come aboard.”

I e Afier ing *permission board," the Olficer of
the Deck will inspect your orders and grant you permission to board,

THE EXECUTIVE OFFICER

Daties and responsibilities -

The Executive Officer is the number two man under the Captain. His responsibilities
anz to provide leadership 10 all men under him while maintaining a fecling of good
spirit. The Executive Officer will take command of the ship during any absence of
the Captain. It shall be the responsibility of the Executive Officer to insure the opera-
tional status of his vessel by inspecting and cycling equipmens in the following areas:

1) Control room

2) Machinery compartment
3) Tarpedo roam

4) Engine room



CONTROL ROOM i

PERISCOPES

(Anack &.Oha:rvlumﬂ

Use you ine the exact bocation of an object on the surface. The
left .md nglI |Amw] keys will adjist the heading of the scope. When you have lo-
cated an object, ke nole as 1o its location.

Scopes should anly be used # periscope depth (approx. 70°). Severe damage may
occur if the "attack scape” is used ot speeds in excess of 3 knots. Severe damage
abso occur if the “observation scope” is used af speeds in excess of 12 knots. .

wNm\uN ol

The sonarrman s situsted in the control reom next i the radioman and to the lefrof
the control panel, Contact with the sonarman and radicman can be made by walking
aver b therm and wiking 1o them.

COMMUNICATIONS

Coded messages

All messages received aboard the U5 5. Blackhawk will be in coded format and shall
be received through the radioman.

Decoding messages

Aboard the U.5.5. Blackhawk can be found a book entitied LS Naval Intelligence
Decoding. This book must be used in conjunction with your technical manual. The
word keys used for decoding can be found within the “boxed shaded” arcas. The
coded numbers represent page, line and word. All coded numbers are in the range (-9,

CHARTS

(Located in control manm)

Course ploning

Enclosed within the packaging of this game is a foldout map. Use this map for deter-
mining and plotting your course heading.

Coordinates

Lnn;nmhwm plot your course on the foldout map, When it is necessary for
the submarine to wm:ﬁmm make note of the longinede and latitade

of the *waypoint’ {the point af which you'll change direction). These are your coor-

dinates.

The initial overall course to be followed will be given to you using landmarks. Using

the foldout map and the landmarks as a guide, chart your ‘way points’ on the map and

then enter them into the computerized charts table bocated in the control rom. Yoa
[




may also receive information via radin, of ather specific way points for rendezvous
purposes. Type: look map to get a close-up view, The flashing point on the map rep-
resenis your vessel at its current location.

‘To begin entering way points Type: plot course.

When ing the way points, e di keys until the longitude and latitude
that you b Sl he fobde displayed. Dx he [ENTER] key
on your keyboand 1o enter the way paint. To change a way point already entered

Type: change point. Repeat the above sequence until vou have entered all your way
points. When entering the last way point, depress the [ENTER] key twice.




CONTROL PANEL

L MAP 18, ATTITUBE INDICATOR
1 FIRE CONTROL PANEL IWHEEL
A VERTICAL SONAR 0. CLOSED CIRCUIT TV ONOFF
4 RANGING SONAR 10 TORPEDO TURE INDICATOR ONOFF
£ DEPTH GALGE 11 TORPEDO TURE FLOOD OGN OFF
& WATER TEMPERA' 2L FIRE CONTROL PANEL ACTIVATE
T. TIME CLOCK 24 HUDDER INDICATOR
& SPEED {IN KNOTS) 15 EMERGENCY RALLAST CONTROL.
% REM INDICATOR 26 HATCH INDICATOR
10, STERN PLANE INDICATOR 10 COMPASS
1L 1 ATOR
12 DIVE LEVER 19, BOW PLANE INDICATOR
13 ENGINE LEVER 10, HEADING INDICATOR
BALLAST INDICATOR 30 MULTIPURPOSE VIEW SCREEN
SILENT RUN OXOFF N THROTTLE SPEED INDICATOR

16, SILENT RUN INDICATOR
17. SONAR ON'OFF

3L DIVE PLANE INDICATORS



1. Map Display:
Use wo determine present location at all times,

2, Fire Controd Panel:
“The Fire Control Panel comsists of four controls. From left 1o right their functions
are as follows:
A Select weapon (Use the Shift F5 key, o click on with mouse .

Target selection is fully automatic.

B. Lock on target [ Use the Shift F& key, or click on with mouse),
C. 310 Imaging Display (Use the Skift F7 ke, or click on with mouse ),
. FIRE (Use the Shift F8 key, or click on with mouse).

SONAR:
There ane two types of sonar used in the U.5.5. Blackhawk:
Passive sonar - Listening for sound produced by other vessels, responsibility of
sonamman,
Active sonar - Sending out sound waves to detect underwater ohjects. Size and
distance can be measured when an object has been detected. Active sonar comsists
of Vertical and Ranging Sonas, explained below.

3. Vertical Sonar:
Vertical sonar i I above and below your ine to a solid
object such as an iceberg or the ocean floor. The center paint on the screen repre-
sents your vessel. Each line on the screen represents 10 ft above or below your
vessel. When an object is present within 100 ft above or below the sub, the lines
on your screen become highlighted 1o indi distance of the object from
wour lpcation.

4. Ranging Sonar:
Ranging Sonar ind bstacles within 1000 yd. radius

Diisplays cument water emperatisne in degrees
Celsius.

7. Time Clock:
Displays current
time of day.

8. Speed Indicator:
Displays speed in
krots.

9. RPM Indicator:
Dhsplays engine
Revolutions Per
Minute.



10k, Stern Plane In dicator:
Indicates the angle of inclination of the Sterm Plane,

11, Coordinate Display Screen (Position Indicator):
This screen shows you the course coordinates of your last way point.

12 Dive Lever:
Use this lever to increase or decrease ballast, which will allow you to set the bow
and stem planes so that your sub may surface or dive. Using the up and down
[Amow] keys, move the bever up and down. Using the mouse, place the mouss
cursor on the lever and hold down the left mouse button. Now move the cussar in
the direction you wiih o adjust the lever.

13. Engine Lever:
Use this lever to adjust the nanning speed of the submarine. Use the [+] key 10 ac-
celerate, the |-] to decelerate. Using the mouse, place the mouse cursor on the
bever and hald down the left mouse buiton. Now move the cursor in the direction
wisu wish b adjust the hever.

14, Ballast Indicator:
Indicates hallast level in fnﬂr separate tanks aboard the submarine.
15. Silent Running On/(1T:
Amvnt«csummu Sliﬂl Run, When Silcm le is active, nolse
reducing the

Ilkdmddmmw lMlie force. FUsc JM Shift F4 kev, or click an with
mnuse |
16. Silent Run Indicator:
Indicates whether Silent Running is active.
17. Somar On/OIT:
Activates of deactivates the active sonar.
i Use the Shift F3 key. o click an with mouse).
18, Attitude Indicator:
Giauges the vertical angle of the submarine.
19, Wheel:
¥ou can change direction using the beft and right [Amow] keys 1o rum the wheel.
1 you're using a mouse, place the mouse cursor on the wheel and hold down the
left mowse batton, Continue holding the left button as you move the cursor to the
left or right.
20, Closed Circuit Monitor On/iOfT:
This moaitor enables the navigator 1o see any obstacles in the path of the sub. The
closed circuit system is vital 1o successful navigation.
(U'se the Shift FI key, or with click on mowse).
21. Torpedo Tube Flood Control Indicator:
Indscates whether Torpedo tubes have been flooded,
0. anpedo Tube Flood On/OfT:
Floods torpedo tubes, Switches automatically when weapon locks on.



23, Fire Control Panel Activate Bulton;
Lowers Fire Control Panel from ceiling for easy access.
{Lise the Shift F2 key, or click an with mouse).
24. Rudder Indicator:
Inlicates the current posithon of the Rodder.
25, Emergency Ballast Control:
In the event of an emergency, it may be necessary for the Blackhawk to surface
quick])‘. Thrunﬂguv:y ballast allows the sub 1o surface aulomatically under

26, il Indk'llon
“There are 3 exterior hatches aboard the UL5.5, Blackhawk. The purpose of the
hatch indicators is 1o keep you informed as to whether the extersor haiches are
open or closed. If an indicator is Highted, a harch i open.
27, Analog Compass
pass heading by the position of a needle in relation to s compass point
Indicating true Nosh,
u (.mme Display Screen (Latitude Indicator):
sereen presents you with your current latitsde coordinates ut ull times,
9. !ou- Plane Indicator
Indicates the angle of inclination of the Bow Plane.
30, Heading Indicator
Diisplays compass heading in nunibers.
31 Multipurpose View Screen
Use 1o view weapons selection when using Fire Control Panel, also serves as
monitor for Clased Cireult Television.
A2, Throttle Speed Indicator
A Lights out- Throttle Stopped.
B. 1 light- Throtile shoew
C. 2 lights- Throttke 1/3
. 3 lights- Throttle 273
E. 4 lights- Throttle full
F. Al lights red- Thromle reverse
33, Dive Plane
Indicators
Indicates dive
plane posilion




TORPEDO ROOM MISSILES

HARPOON

The “Harpoon® mussile i an active radar homang weapon, It delivers a 1000 1b,
penetration/blust warhead over ranges of up to 150 nautical miles against surface ship
targets. i {5 propelled by 3 solid rocket booster and wrbojet sustainer, and after reach-
ing & maximum altitude of 5,000 . it cruises at high subsonic speed.

 FR oY

5 RAY
The *Sting Ray" is active/passive homing to 35 nautical miles st 90 knats. It delivers a

1000 I, warhead (o a depth of 5,000 fi.

EMERSON CTRIC MK 2 TORPEDD DECOY
The decoy torpedo is used a5 8 coumer measure against attack. The decoy emits o
sound signature identical 1o the mother ship from which it is launched. Decoys need

not be targeted.




EQUIPMENT & SYSTEMS

EXPLOSIVES
Plastic explosives for underwater demolition can be found aboard the U.5.5, Black-
hawk,

TUBES
The U.S.5. Blackhawk has four forward torpedo tubes which may be used to lunch
all weapons.

MACHINERY COMPARTMENT

The machinery companment consists of tools used to reproduce parts in the event of a
heeakdown. Onher life suppon systems can also be found, sach as fresh water, oxygen
and scrabber systems,

FRESH WATER SYSTEM
Sea water is desalinated and then distilled to remove minerals. Fresh water is stored
for erew use and 10 generate oxygen.

OXYGEN

Fresh water is pumped into oxygen generator, high amperage (1,050 amps) eleciricity
separates the hydrogen from the oxygen. Hydrogen is pumped averboard and oxygen

is stored in a bank of high pressure oxygen bodtles. Oxygen 14 bled inlo atmosphere as
required.

SCRUBBERS

Various gavies inthe i d al e bevels by filtering out
encess,

NUCLEAR COMPARTMENT

General Electric pressurized water coobed 560 reactor. Two geared turhines, one
shaft. Due 10 the extreme hazand of radiastion exposure in the nuclear reactor compart-
ment, admittance is nol allowed.



DEFENSIVE STRATEGY (WHEN ATTACK IS IMMINENT)

PREPARING FOR ATTACK
If you believe attack is imminent, it's very imporntant 1o react quickly! The following
suggestions will aid yoa in the survival of yoar submarine and crew,

RUN SILENT
The key to submarsne survival is evasion |h|wgh “stealth’ or sibem running. The
LLS.5. Blackhawk is equipped with the laest in clectronic noise eliminating
iransiducers which are bocated s various pulms alang the propelier shalt, The
antached 1o the steel mcshal: They pick up
,gmcm:d sound waves which are fied i he exact
opposite phase sound wave which cancels out the noisc. This makes for much im-
proved sikent ruaning: however, the ransducer s oaly effective if the submarine is
operated ot speeds of 5 kivots o less,

SONAR
Passive sonar is a must, because active sonar will give away your position. As 5000 s
possible, confirm a fix on enermy larger.

WEAPONS
You must first select o weapon, When using harpoon missiles und Sting Ray Tor-
pedoes you MUST fiest bock on w}nunzgﬂ Remember that 3 weapon launch may

Eive away youar p g silent running.
Decoy torped may be wsed 1o draw enem; fire of under attack.
DIVE DEEP

Diving deep and changing course will ail your evasion tactics. In some instances the
Botrom terrain will help hide your position.

INVERSION LAYERS

A layer of waber that is warmer than the surrounding water is called an inversion layer.
An inversion layver

will deflect sonar

signals from above.



US NAVY TERMINOLOGY

Yes Sir

Ti

Rear of ship

Mear, toward or in the stern of a ship

Fromt of ship

Left side of ship

Right side of ship

Submarines rear navigational diving planes
Submarines front navigational diving planes
Submarines lefi/right navigational control
Diving and surfacing controls

Flooding torpedo tubes in preparation for launch
All control room systems ready for diving
Passage way in, out, or through submarine
Ships propellers

Identifying ships through their unique sound
Sending active sound waves

Listening for sound created by other ships
Active sonar sound



FIRST AID PROCEDURES

CARDIOPULMONARY R-I.ISC'ITATION {CPR)
CPR isan life saving To how CPR in life,
consider these twa definitions of death;

A, CLINICAL DEATH - The heantbeat and breathing have stopped. This is also
known as near or uppumnl death, and it may be avened, mlﬂﬂsﬂd_ “Sudden Death®
15 sudden, | death, 5 o sudden death are:
Cardist arvest

Electric shack

Drowning

Drug overdose

Suffocation

Severe allergie reactions

B: BIOLOGICAL DEATH - Permanent brain death due 1o lack of oxygen.

During the first few minates of clinical death, prompaly initiated CPR may tum the
wictim hack to productive life. Withowt CPR, baological death will oecur, Speed in
stanting CPR and in getting specialized medical care for the victim are the keys 1o

saving lives.

When CPR is staned within 4 minutes, the victim’s chances of leaving the hospital
alive are four times greater than thase of a victim who does not receive CPR unnil

afier 4 minutes.

A5 a rescuer acting in good faith, you should remember that once CPR has begun,

you may stop ealy when:

1. The victim recovess

2. Another trained individual takes over.

3.¥ou are foo exhagsied Lo continue,

Cardiopulmanary resuscitation inclsdes three basic rescue skills, the ABC'S of CPR:
Airway, Breathing. and Circulation.

AIRWAY - The first action for of the

mrwny It is impostant 10 remember that the bac efliwlouauemd ﬂweplgl.ocusut
A airway ob on in the vietim. Since the

Imgve llnvﬂly and the epiglottis, indirectly, are unchealou-e Imerjaw ||1|mg the

head back and moving the lower jaw (chi ifis the tongue and pigh

tis from the back of the throst and wsually opens the airway.

BREATHING - When breathing stops, the body has oaly the oxygen remaining in

the lungs and bloodstream. [t has no other oxygen reserve. Therefore, when breath-

ing stops, cardiac arrest and death quickly follow. Moath-to-mouth rescue breathing




s the quickest way 1o get oxygen into the victim’s lungs. There is more than enough
oxygen in the air you breath into the victim 1o at Jeast panly supply his or her needs.
Rescue heeathing mast be performed until the victim can breath on his or hes own or
wriil trained professionals take over,

Remember: If the victim's heart i beating. you must (1) maintain an open sirway
and (2} breath ( for the adult vietim) once every 5 seconds (12 times per minutc). If
the victims hesrt is nol beating. you will have to perform mouth-to-mouth rescue
breathing plus chest compressions.

CIRCULATION - The third skill of CPR is chest compressions, which replace the
hearibeats of the victim. They maintain some blood Mlow to the lungs, brain,
COMmnLry :m.:m- and viher major organs, Any IIW chal cOmpressions ane per-
formed, beeathing must also be p

NOTE: THE FDLLIJ\HVG l( NE MAN) CPR PERFORMANCE GUIDELINE
WAS TAKEN FROM EARTSAVER MANUAL' BY THE
AMERICAN HEART .LWUCIA N

1. Lay Vietim O Back (Head Musi Not He Abave Level (f Heart)

2. Shake And Shaut To Establish Respontiveness

3. Cal For Help

4. Establivk The Airway { Open The Mouth And Sweep With Fingers)

5. Look, Listen, And Feel (Look Far Chest Rising, Livien For Breath, Feel For
Breath With Cheek.}

6. Give 2 Good Breatis (After Titting Head Back And Opening Mauth)

7. Repeal Step 85,

8. Cheek Pulse For 5-10 Seconds.

9, After The Above Steps And SHll No Vital Signs, Begin Compressions. Pasition Heel
0f Hands Approx. 3" Abave The End 0f The Sternum. Compress The Chest 1 10227
At A Rate Of 100 Times Per Minute. The Ratto 0f Compressions To Breaths {for | Per-
soa) Are, 15 Compressions To 2 Breaths. Check For Pulse Every Minute, Continue
Siep 85 Uniil Breathing And Pulve Are Established (b, Uniil Competent Help Has Ar-
rived To Relieve You.




HOW TO READ THIS MANUAL

Theoughous this manual we will use the following ways of representing information:
MENL COMMANDS will be CAPITALIZED.
Exzmple: SAVE. RESTORE. QUIT. PAUSE GAME
Typed commands will sppear as bold type.
Example: “rype: Inumpl.e game command ]|
“Lype: ool \sierra
Portions of the commard line nod meant 1w be typed will aer appear in bold type, For
example, in the line ‘type: od 'sierra’, ‘type:” should not be typed.
!EXAMPLE TDLTl and [Keystrokes| will appear in brackets sefting them off from the
surroundi
Example: |wwll: OF GAME] [NAME OF DIRECTORY| [Spacebar], (Tab], [Page-
Upl
The brackets are not keystrokes and should not be typed.
Two or more keys that should be pressed at the same time will be sepasated by o byphen
£-). This hyphen is not & keystroke, and should not be typed.
Example: *Press [Cirl-1] 1o view your inventory.’
If a space appears between parts of a comemand, it s meant 1o be typed.
Example: ‘type ed 'sierra’ (e space between od and 'slerra should be ryped as pan
of the command)
The term "diskette” is used to nefer o either 3,57 or 5,257 data storage disks

ALL SYSTEMS
PLEASE NOTE: If there is @ README file on your game diskette. It may contain
impartant information and instructions that were nol available of the time the
and other materials for this game were printed, Failure to review the
README file before installing the program may cause unexpected results during
loading or playing the game.

MS-DOS README INSTRUCTIONS
From DOS, 1ype readme to see the README fil . Use [Pagellp){PageDown]
keys to scroll throwugh the file,

ATARIST README INSTRUCTIONS

To view the README file from the deskiop, double-chck on the README.DOC icon.
You will see 2 message box. with choices for SHOW, PRINT, and CANCEL. Choose
SHOW to view the file onscreen one page af a time, Press [ENTER] to see the next
screen. Choose PRINT to print the file. Choose CANCEL to escape the message box.

AMIGA READMI: I\STRUL'TIUN-S
Insert your system. D ick on the CL1
icon.

18



Users with one drive: Copy the TYPE command into your RAM disk. See your
~ Amiga owner’s manual hlnnnulmlmmbnh L Tm type reaidine.

drive DF1:. Type od dfl:=. Type: type readme.

GETTING STARTED: INSKETTE DRIVES

is always advisable 10 make back-up copies of your master program disketies 1o

increass the life of the masters and guard agains accidents. Follow your computer’s

 inseructions to make copies of all game diskettes.

E.vm if you will be playing from 3 hand dnk you may want o fomat nblmkﬁdcum
in,

fact good idea,

game from your hard disk, Follow your computer’s imstructions 1o I'«'mul a hlanl.
 diskette and keep it handy for saving your game as you play. For some helpful tips on
- saving games, see the “Saving Your Game” (Page 24} section of this manual.
When installing your program, you may be prompéed to insert a *Drivers” disk. If vou
' receive this prompt, pim:nmmc your disks and insert the disk marked *Drivers’ and
press [ENTER]

separte ‘Drivers' disk.

M5-DOS

INSTALL THE GAME

- Place the back-up copy you have made of Disk | info your disketie drive. Type the leter

of the disk drive you have placed the disk ino follmmd by a colon (for example: az),

“and press [ENTER], Type: install and press |[EN

- Answer the onscreen questions using the upand&wn | Amrow] keys to highlight your
selections, then press [ENTER] to select. You will be asked if you wich to nstall the

on your hard disk. 1f vou do e wish the game 1o be installed on your hard disk,

- press [ESC] to skip this siep. If you want 10 install the game on your hard disk, eater the

letter designation of vour hard disk (usually Ch and follow the prompts.

PLEASE NOTE: Even if you install to a hﬂhﬂ!’l the install procedure will write a

ile nomed RESOURCE.CFG to Divk 1, F il
SK | MUST NOT BE WRITE PIOTE{TED. No other files on Disk I ave written

ehanged by the install command,

DING INSTRUCTIONS

Il‘:un disketics:

msh'u-d press [ENTER],
n hard disk:

om your root directoey, type od \slerra and press [ENTER].
‘I')'pe [SPECIFIC COMMAND] and press [ENTER|.



SAVING GAMES TO DISKETTES

PLEASE NOTE: If yon're disk h

diskette ready before 8 W d that you ereate several
directories an your save game disk in order to assure adequate space for save game

storage.

Choase SAVE GAME from the File mena or press the [FS] key. The Save Game menu
will appear.

Use your [Tab] key 1o choose CHANGE DIRECTORY. Backspace of press [Cirl-C] 1o
chear the command line.

Type the lener of the drive you are using for
at) and press [ENTER].

Type the name of your <aved game and press [ENTER] to complete the SAVE GAME
procedure. If your disk for saving games is full, you may reformat it (this will erase the
saved games on the disk) and se it over, or use another formatied blank disk

SAVING GAMES TO HARD DISK

11 you chaose 10 save gamses o the hard disk, the program will automatically iry to save
&0 the game's own directory, If you run out of space for saving games. try one of the
following altermatives:

Save additional games 1o a diskette.

Save games 1o a differcat directory by choosing CHANGE DIRECTORY from the
SAVE GAME menu (inside the game).

Create a new hard disk dircctory from DOS, using DOS instructions, Delete all saved
games and the saved game directory from your hard disk by following DOS instrac-
tions (outside the game). The program will create a new index file within the game
Alirectory.

ATARIST

LOADING INSTRUCTIONS

Note: If you are using an Atari $20 ST without memory expansion, turn off all desk
accessovies {remame ACC extension ACX) before runming your Sierra game.

L. If you are playing the game from diskertes: Place Disk 1 in drive A, and open the
disk by double-clicking on its icon. Stan the game by double clicking on SIER-
RAPRG.

2. If you are playing the game from a hard disk: Open the disk by double-clicking on
15 icon, then open the game folder by double-clicking on the game folder icon. Stan
the game by double-clicking on SIERRA.PRG

HARD DISK INSTALLATION

Please note: More than 512K of memory is needed in order o run Skerra games on your
ST 1f you have o hard disk.

1. Open the hard disk by double-clicking on its icon,

20



Create a game folder by choosing NEW FOLDER...from the File menu, Open the
folder by doable-clicking on fts icon.
Place Disk | in drive A
Copy the game disk into the new game folder by dragging the drive A ko into the
window you opened in i
- 5, Repeat steps 3 and 4 for cach of the other game disks.
6. Put the master disks away in a safe place.

 CHOOSE A MUSIC DEVICE (Optional)
Your Siema game is initially set up to play music and sounds through the Atari ST's
speaker, If you have one of the supported MID synihesizers, yoa may run the
SIC program to have the game play music through the synihesizer.
1. Open the game diskTolder by double-clicking on its icon,
Run the MUSIC program by double-clicking on the MUSIC.PRG icon.
3. Select MUSIC DEVICE [rom the Options menu.
4. Select your synthesteer (or *Atari ST Inemal Sound”) by clicking on the ap-
priate buiton. Then click on OK.
bect INSTALL GAME from the File menu. This will replace the

1o b your ‘an beforg staning the game.

I LLING THE GAME

OTE: RENAME your cop it i he words'COPY OF from
Mmﬂmm'CMOF‘MMNMUH’MM!MM:»}‘AH
capies, the system will continue to ask for the original disk, and will not run the

Boot your system with Warkbeneh, and insent Disk 1 of your Siera game.
2. Double-click on the disk icon, then double-click on the INSTALL icon.
Follow the onscreen prompts, choosing your selection with the mowse by clicking
ce: o the ilem,
4 Yn\lwlllb:ukﬂdllywmsh!mmllﬂlhemmmthuﬂdnl 1 you do mor
N1 T you want 1o install the

Ulking your mouse, select the drive on which you wish in install the game.
&, Follow th prompts iplete thy i
ADING INSTRUCTIONS

n Diskettes:
you have less than | megabyte of memory for your Amiga, um yous system off
and disconniect any extemal drives,

Insen Disk | into drive DFO:.
3. Tum on your system,

21



From Hard Disk:

1. Load Workhench and double-click on your hard disk jcon.
2, Deable-click on the SIERRA GAMES drawer.

3. Click an the drawer for the desired Siema game.

4. Click on the game icon.

ALL SYSTEMS

MOVING YOUR CHARACTER

You may move your character on the screen with the [ Arrow] keys, the numeric keypad,
the joystick, o the mouse. To halt vour character’s steps with the keypad, press the
number 3, or press the last wsed direction key again. Do pol attempt o move the
character by holding down the direction key. This will cause the churacter 1o start
and stop continuously, resulting in very slow progress.

Using the mouse, position the ammow where you want the character 1o move, then click
the keft mouse baton (if your moase has multiphe buttons).

~ 1 P
ol
-]~
'“ ~

MENUS
When you press |[ESC], a menu bar will appear a1 the top of your screen with several
mens that can be opened 1 shaw the commanid choices available 1o vou,

KEYS TO USE IN THE MENUS

Use the left and right |Arrow | keys 10 open & menuw, and the up and down [Arrow] keys
1o highlight items within a menu,

Press [ENTER] oo select a highlighted command.

Press [ESC] to retum 1o the game without choosing a command.

GAME SPEED CONTROL

Al times it may be uscful 10 slow down the speed of the game animation in order to
negoliate a tricky section, of observe something more carefully. A1 other Limes, you may
wish to speed up the game actions. To increass or decrease animation speed. choose
FASTER or SLOWER from the Specd Mena, or use the [+] key to increase speed. the
11 key o decrease speed, or the [=] key to refirn 10 normal animation speed.
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SHORT CUTS FOR CDM“B\ CﬂM\l.lNIlb

You can wse function keys to shon cut many
F1] Help
F2] Tussll: sound onjoff
1F3], |Spacebar] Repeat
[F5] Save Game
1F7] Restore (saved) Game
1¥F9) Restart Game {{rom beginning)
[ Tabj Inventory
[Ctri-1) Inventory
[Cerl-P) Pause Game:
[Ciri-Q] Quit Game
[+ Increase Animation Speed
Il Diecrease Animation Speed
I=1 Noermal Animation Speed
[CirkeV] Change Valume
USING YOUR TAB KEY

‘While playing Sicrra games, your [Tab| key will perform two major functions, Yoo will
use it 10 review the ilems in your inventory, and also {if you'ns not wsing 0 mouse) o
select options from certain menws. The following menus will requine the use of the [ Tab|
key for highlighting menn options:

USING THE MOUSE (optional)
To move your charscier sing the mouse, posilion the armow 10 where you want the
characier to move. then click the left mouse batan,

RETYPING COMMANDS
1f you wish to repeat a command select RETYPE from the ACTION menu or press the
ISPACEBAR| or [F3]

INVENTORY
1 you wish to see the items you are carrying, select INVENTOR'Y from the Action menu,
press [Cirl-l), or pressihe | Tab] key. A li camying will be disp

To look mare clasely at an item. use your | Arrow] keys 10 highlight the item and press
[ENTER]. A picture of the item, along with a briel description. will appear on your
screen. Press [ENTER] or [ESC] 1o resume play.



PALSING YOUR GAME
IF you wish 1o pause the pame, select PAUSE from the Action menw, or press |Crrl-P).
Press [ESC] or [ENTER] to resume play,

SAVING YOUR GAME

If you wish 1o save your game, sclect SAVE from the File menu, or press [FS). Tnullw
for emurs in

your game in pmswu and that you save several different games from different poims.
2% you play. You will always want 1o save your game before encountering potentially
dangerous situations. You should also save your game after you have made significant

progress.
Plewse note: I you're playing from diskettes, you must huve a separate formatted
diskette ready before you can save a game. Since each disk can only hold a limited
number of games, we recommend that you have more than one disk formatted, in
order to asure adequale space for save game storage.

IT you choase bo save games o your hand disk, we sugges! that you create one of mone
save game directorics or folders on your hard disk. See your computer’s instrictions for
creating directories of folders. You may name your saved games using standard English
phrases. For examphe, if you are standing on a sandy beach. you might call your game
“standing on sandy beach’. or simply “heach’.

RESTORING YOUR GAME

Select RESTORE from the File menu, or press [F7]. You will be prompied o seboct the:
game you wish to festone. iOna smyc dn\resyslem vou will be prompled to insent your
save game disk), Hi lect RESTORE. I the game you wish
1o eestiwe s in a different directory, sebect CHANGE DIRECTORY.

Please note: If you do not have a mouse, use the | Tab] key 1o togghe between RESTORE
and CHANGE DIRECTORY.

QUITTING YOUR GAME
To stop playing. select QUIT from the File menu, or press [Cirl-Q),

RESTARTING YOUR GAME

IF you wish 1o restan your game st any time during play, select RESTART from the file
‘e, of press the [F9] key, The game will begin again (INSERT GAME SPECIFIC
INFORMATION).

COMMUNICATING WITH (‘(ll'lF,NAMI‘ TCEMAN

You can generally interact with th il
as little as a noun and a verb. For instance, the command sit in the chalr can be shorened
1o 5l in chair, or even sil. Unless otherwise directed, follow all typed commands with
[ENTER]




Many characters in the game will have information of one kind ar anather for you. To
talk with a charscter, type: talk 1o [character] (for example: talk to man).

You may encounter objects you need along the way. To take an object, type: take or get
lobject]. For example, take the note. You will need to use the ohjects you acquine s
you explore. You can try different things such as typing: use the [ohject]. or give the
lobiect] to [character]. Different approaches to a puzzle may bring about a differens
outcome.

Ioonlllmnlej umu[m L}, then type the name of the object.

To get 2 general description of the cumment room or scene, type look aroand, or use your
mouse 10 choose LOOK from the menu,

A message window will appear after you enter each command, 2nd at other times during
the game. When you have read the message, press [ENTER] 1o remove the window and
resume play.

Codename Iceman undersiands many common verbs, Here are some you might try:

ASK DROP SEARCH TELL
BUY EAT PLAY SIT
THROW CLIMB GET PUSH
TAKE USE CLOSE GIVE
READ STAND WALK DRINK
OPEN RUN

LOOK everywhere. Thoroughly explore your surroundings. Open doors and drawers,
book wnder things and behind things for valuable objects and clues. Look closely at all
ohjects you encounter or you may miss important details.

EXPLORE cach area of the game very carefully, Search every area of the game. Be
careful!! There are many hazards awsiting yoa!

DRAW A MAP 55 you progress through the game. Make a note of each area you visit,
and include information about objects found there and dangerous areas nearby. If you
Miss an area, YOU may miss an impornant chue!

GET ohjects you think you will need. You will come across a nember of objects that
miay be of use 1o you kater. You can see an inventory of iems on hand by pressing the
[Tab] key at any time.

USE the itermns b or 10 help you to make
jprogress and discover more cl.ucs

BE CAREFUL. and remain alert i all ti i miay strike in th unlikely
of places.



SAVE YOUR GAME OFTEN, especially when you ane about 1o 1ry something new
or potentiaily dangerous, This way, if the worst should happen, you won't have to stanl
ull over again from the beginning. Save games at different points of the game, so you
will be able to retum o desired point in the game. In effect, this will enable you 1o
travel hrough time and do things if you wish,

DON'T GET ISCOURAGED. If
don't despair. Spend some time exploring another arca, and come back later. Every
problem in the game has at least one solution have more than one. i
solving a problem one way will make it harder to solve the next. and sometimes it will
make it casier. 1f you get stick, you might try backtracking to an earlier point in the
game, then choasing a different path, If all else fails. you can buy the [Name Of Game]
it book from the dealer who sold you the game, or you can order it direcily from Sierra
On-Line by calling (800) 326-6654.

BRING ALONG SOME HELP. You may find it helpful (and fun) to play the game
with a friend. Twa (or more) heads are betier than one at inerpreting clies and solv-
ing problems

NEW FEATURES

Note: Codename: FCEMAN fearures o new and improved playing system for casy in-
terface. Here are some of the imp we think you'll ¢

1. LOOK - 1f you simply type look in any room, you'll automatically get a descrip-
tion of the obyject(s) directly in front of your character. If you type look ai [person] or
lobjeet], and your chamcter is not facing that person or object, your character will
1urn i face the persen or object before the game gives you a deseription.

2. GET, TALK, TAKE, (COMMANDS OTHER THAN *LOOK") - In some
cases, you may want 1o 1alk o 4 person or get an object that is not directly in from of
you. Previously, the game might have responded by saying “You're not close
enough’, With ICEMAN s improved playing system, if your character isn't close
enough, he'll astomatically move choser 10 the person or object before getting it or
ralking 1o himder.

3, DOORS - Most doars in the game will epen automaically when your characler ap-
proaches them, This eliminates repeatedly lyping open door.

4. MOVING YOUR CHARACTER - To casily walk 10 a visible point on your
screen, type walk to [object]. Your chasscter will atomaically make his way 10 the
desired point. Moving your character is generally easier with the improved playing
wySLEm.
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NEED A HINT?
1 you find yourself “a lintle stuck” while playing a Sierra game, try the following ideas:
1, 1f you have a modem, you can talk to the Sierra Bulletin Board through the follow-
ing number:

1209) 683-4463
Our seftings are 300, 1200 or 2400 Baud: & Data; N Parity; | Stop Bit, Our sysop
will be happy 1o belp you.
2, Many other bulletin boards also provide hints 10 many of our games.
A. CompuServe: Go into the Gamers Forum (GO GAMERS) or write E-Mail 1o
TEH004,2143,
B. Prodigy: Write E-Mail to 'HTWS90E', or go 10 the PC Club and cnter the adven-
tisre games forum (Jumpword: PC CLUB),
€, PCLink: Select PCLink Plos, enter Publisher's Connection, select Publishers
Fosums, then Sierra On-Line. E-Mail may be written to the User ID *SierraOnli’.
. America’s On-Line: Select the KEYWORD option from the “Goto” menu, and
type: Slerra. E-Mail may also be written o the User 1D *Sierms”,
E GEnie: From the main menu select 10 (Games), then select | {Games Round
Table). Select | (Games Bulletin Board), and type set 22 at the *?* prompt. This will
take you into the Sierra On-Line area.
For more information on these BBS lines, you can call thess 1oll-free numbers:

CompuServe (S00) 848-8199

Prodigy (500) 822-6922

PCLink () 458-8532

G Enie ($00) 638-96.36
3. The magazine Questbuster's Journal is a helpful source of many game hints.
4. Your local software dealer may carry our hint books, or may be willing to order
them for you,
5. If you are unable 1o obtain a hint book through a deaber. you can onder one directly
from ws. Call (800} 326-6654 10 place your order with a Visa, MasterCard or
American Express card. or write Sierm On-Line Inc., Order Depanment, P.O. Box
485, Coansegold, CA 93614,
6. 11 the hint book is nat yet available for the game vou are playing, call our
automated hint line 1 {900) 370-KLUE to receive a hint. NOTE: Califomnia resi-
dents, please dial (900) 3705113,

THIS SERVICE IS AVAILABLE 24 HOURS A DAY. THE CHARGES ARE: 75
CENTS FOR THE FIRST MINUTE AND 50 CENTS FOR EACH ADDITIONAL
MINUTE. IF YOU ARE UNDER 18 YEARS OF AGE. YOU MUST HAVE A
PARENT'S PERMISSION TO CALL. THE CONTENTS OF ALL MESSAGES
ARE SOLELY THE RESPONSIBILITY OF SIERRA ON-LINE. HINTS WILL
NOT BE GIVEN ON OTHER SIERRA TELEPHONE LINES.
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PROBLEM DISK?

TECHNICAL HELP (MS DOS ONLY)

Il you are having problems with a game disk, try these sugpestions before assuming the
disk is fa
If you receive any of the following messages:

1. “Insert Disk (#)° when you have already inscried that disketie, of have installed the
game an your hard disk

2. "Dut of Handles' or *Out of Heap’, or if the game locks up at any point

3. “Disk Error”

Then you may have memory resident programs koaded into your RAM memory. You
will need 1o boot your system from a diskene containing your operating system only.
Follow these instructions (o create 4 *Sierra Boot Dusk”.

First format a blank disk with DOS system files (using /s) to make o bootable disk:

FORMATTING FROM A HARD DRIVE

A} Place a blank disk in drive a2

B At the C prompl, type: format a2/s

NOTE: If your A: drive is a high density drive and you are asing double density disks,
you will pecd o type: format 2 (for 5.257 disks)

or type: format a/n:9s (for 3.57 disks)

FORMATTING FROM A MSKETTE DRIVE

A} Place your original DOS disk in drive A

B) Atthe A prompl, type: format acs (be sure 1o switch 10 a blank disk when
prom| by the FORMAT program.}

NOTE: If your A: drive is a high density drive and you are using double density
disks, you will need 1o type: format azMfs (for 5.257 disks)

o type: format a:fn:%s ifor 3.5 disks)

C) Press [ENTER|

D) Respond to DOS prompts.

Now you should create a CONFIG.SYS file on your Skerra Boot Disk. with a files=20
stasement, Follow these instrctions to create this file:

Al Type: ENTER|
B Type: copy con conflgsys [ENTER]
C) Type: files=20 |ENTER]
D) Press [F6) [ENTER|

You should see the message: *| File(s) copied’, You will now have 1o re-boot your
computer with your new Sierra Boot Disk in the drive. Tum your computer off then an,
ar press [Cirl-Al-Del|.

If this does not clear the above messages, call (209) 683-8959 for technial help, Our
technical staff will be happy fo belp you.



TECHN[CJ\L “ELI‘I.RLI.. SYSTEMS)
Technical s onlly a teleph 11 wway, Call (209) 683-8989 for convenient.
PETSON-10-PErSon Lervice, of n‘ym prefer, you may request assistance by mail. If you
chaase to write to us with your request, please stale your compuler type and the nature
of your problem.
Il vou find that you need to send for replacement diskenes, send the original disk |in
e size you need (357 or 5.257) 10

Skerra On-Line

P00 Box 485

Coarsegold, CA 93614

Attention: RETURNS
?;Sm w0 inclisde a note stating your compuier Lype, and the size of diskette you need
{5.25" or 31570
W: will gladly upllceyur program lm- nfdwge for the first %0 days of ownership

with your ). After 90 days there

unssmm for 5. 25' diskeries, and 2 s1DDuch:rn= for 35" diskenes,
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WALKTHROUGH

WARNING! The following section inclisdes hines that
expencnoed game players may not want 1o see. Continue reading
ONLY if you have trouble getting started playing
Codename: ICEMAN.



Amesage window Wwﬁummmmﬂmmmmu
meisage, press the window and play.

The apening af the game finds our her, L1, Comsander Johany B, Westlind lounging on a
sunny beach in Tahiti enjoyng a linke well deserved R & R, Next 1o Johrmy is 2 tnble.

Type resd
There is an imeresting anicle.
pe stand up.
Walk left and find velleyball game.
Type play ball
Walk isso water after gir,
Follow CPR proceduse.
Walk 1o lnx! of hotel.
Type open door
When you are standing nside the hosel lobby . facing the desk:

Type ook
mlillmmammdﬂlﬁm
Wl of the mom he east wall.

iption of the door il founge.

Jahnery will sum towsnd sach ohject.

Type smell Mowers.

Johnery will walk o the table and smell the flowers.

Tpe talk b0 clerk

Johney wall walk to the desk.

Type et hey

Press [Tab] 0 vaew inventory. Using your mouse or | Asmow] keys, select KEY and press
[ENTER]. A pictare of your hotel room key will sppear. Press [ESC] 1o resume play.
Walk 10 the sign on the porth wall.

Type book sign

Walk thivugh the door on the east wall,

This enight be a good time to save your game.

Walk tn the empey bar sicel,

OK. Johany, you're on yor cem fiow. Continue explosing the island 1o discover your mission,
Good luck!
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